Chapter 426

Two-Sample Z-Tests Assuming Equal Variance

Introduction

This procedure provides sample size and power calculations for one- or two-sided two-sample z-tests when the variances of the two groups (populations) are assumed to be known and equal. The assumed difference between means can be specified by entering the means for the two groups and letting the software calculate the difference or by entering the difference directly.

The design corresponding to this test procedure is sometimes referred to as a *parallel-groups* design. This design is used in situations such as the comparison of the income level of two regions, the nitrogen content of two lakes, or the effectiveness of two drugs.

There are several statistical tests available for the comparison of the center of two populations. This procedure is specific to the two-sample z-test assuming known and equal variance. You can examine the sections below to identify whether the assumptions and test statistic you intend to use in your study match those of this procedure, or if one of the other PASS procedures may be more suited to your situation.

Other PASS Procedures for Comparing Two Means or Medians

Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be used when the analysis of the data is performed. You should check to identify that the test procedure described below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are different, you may wish to use one of the other two-sample procedures available in PASS. These procedures are Two-Sample T-Tests Allowing Unequal Variance, Two-Sample T-Tests Assuming Equal Variance, Two-Sample Z-Tests Allowing Unequal Variance, and the nonparametric Mann-Whitney-Wilcoxon (also known as the Mann-Whitney U or Wilcoxon rank-sum test) procedure. The methods, statistics, and assumptions for those procedures are described in the associated chapters.

If you wish to show that the mean of one population is larger (or smaller) than the mean of another population by a specified amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority, equivalence, and confidence interval procedures are also available.
Test Assumptions

When running a two-sample equal-variance z-test, the basic assumptions are that the distributions of the two populations are normal, and that the variances of the two distributions are known and are the same. If those assumptions are not likely to be met, another testing procedure could be used, and the corresponding procedure in PASS should be used for sample size or power calculations.

Test Procedure

If we assume that \( \mu_1 \) and \( \mu_2 \) represent the means of the two populations of interest, and that \( \delta = \mu_1 - \mu_2 \), the null hypothesis for comparing the two means is \( H_0 : \mu_1 = \mu_2 \) (or \( H_0 : \delta = 0 \)). The alternative hypothesis can be any one of

- Two-Sided: \( H_1 : \mu_1 \neq \mu_2 \) (or \( H_1 : \delta \neq 0 \))
- Upper One-Sided: \( H_1 : \mu_1 > \mu_2 \) (or \( H_1 : \delta > 0 \))
- Lower One-Sided: \( H_1 : \mu_1 < \mu_2 \) (or \( H_1 : \delta < 0 \))

depending upon the desire of the researcher or the protocol instructions. A suitable Type I error probability (\( \alpha \)) is chosen for the test, the data is collected, and a \( z \)-statistic is generated using the formula:

\[
 z = \frac{\bar{x}_1 - \bar{x}_2}{\sigma \sqrt{\frac{1}{n_1} + \frac{1}{n_2}}}
\]

The null hypothesis is rejected in favor of the alternative if,

for \( H_1 : \mu_1 \neq \mu_2 \) (or \( H_1 : \delta \neq 0 \)),

\[
 z < z_{\alpha/2} \quad \text{or} \quad z > z_{1-\alpha/2},
\]

for \( H_1 : \mu_1 > \mu_2 \) (or \( H_1 : \delta > 0 \)),

\[
 z > z_{1-\alpha},
\]

or, for \( H_1 : \mu_1 < \mu_2 \) (or \( H_1 : \delta < 0 \)),

\[
 z < z_{\alpha}.
\]

Comparing the \( z \)-statistic to the cut-off \( z \)-value (as shown here) is equivalent to comparing the \( p \)-value to \( \alpha \).
**Power Calculation**

This section describes the procedure for computing the power from \( n_1 \) and \( n_2 \), \( \alpha \), the assumed \( \mu_1 \) and \( \mu_2 \), and the known common standard deviation, \( \sigma_1 = \sigma_2 = \sigma \). Two good references for these methods are Julious (2010) and Chow, Shao, and Wang (2008).

The figure below gives a visual representation for the calculation of power for a one-sided test.

![Diagram of z distribution and power calculation](image)

If we call the assumed difference between the means, \( \delta = \mu_1 - \mu_2 \), the steps for calculating the power are as follows:

1. Find \( z_{1-\alpha} \) based on the \( z \) distribution.

2. Calculate the power as the probability that the test statistic \( z \) is greater than \( z_{1-\alpha} \) under the \( z \) distribution with mean \( \delta \):

\[
Power = \Pr(z > z_{1-\alpha} \mid \delta).
\]

The algorithms for calculating power for the opposite direction and the two-sided hypotheses are analogous to this method.

When solving for something other than power, PASS uses this same power calculation formulation, but performs a search to determine that parameter.

**A Note on Specifying the Means or Difference in Means**

When means are specified in this procedure, they are used to determine the assumed difference in means for power or sample size calculations. When the difference in means is specified in this procedure, it is the assumed difference in means for power or sample size calculations. It does not mean that the study will be powered to show that the mean difference is this amount, but rather that the design is powered to reject the null hypothesis of equal means if this were the true difference in means. If your purpose is to show that one mean is greater than another by a specific amount, you should use one of the clinical superiority procedures for comparing means.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power, Sample Size, Effect Size (Means or Difference), and Alpha. In most situations, you will likely select either Power or Sample Size.

The ‘Solve For’ parameter is the parameter that will be displayed on the vertical axis of any plots that are shown.

Test Direction

Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the hypothesis test direction is chosen based on whether the difference ($\delta = \mu_1 - \mu_2$) is greater than or less than zero.

Two-Sided Hypothesis Test
H0: $\delta = 0$ vs. H1: $\delta \neq 0$

One-Sided Hypothesis Tests
Upper: H0: $\delta \leq 0$ vs. H1: $\delta > 0$
Lower: H0: $\delta \geq 0$ vs. H1: $\delta < 0$

Power and Alpha

Power

Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying power implicitly specifies beta. Beta is the probability obtaining a false negative with the statistical test. That is, it is the probability of accepting a false null hypothesis.

The valid range is 0 to 1. Different disciplines have different standards for setting power. The most common choice is 0.90, but 0.80 is also popular.

You can enter a single value, such as 0.90, or a series of values, such as .70 .80 .90, or .70 to .90 by .1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Alpha

Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of rejecting a true null hypothesis. The null hypothesis is usually that the parameters of interest (means, proportions, etc.) are equal.

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10. Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests. You can enter a single value, such as 0.05, or a series of values, such as .05 .10 .15, or .05 to .15 by .01. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on \( N_1 \) or \( N_2 \) or both.
The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter N1, solve for N2**
  Select this option when you wish to fix \( N_1 \) at some value (or values), and then solve only for \( N_2 \). Please note that for some values of \( N_1 \), there may not be a value of \( N_2 \) that is large enough to obtain the desired power.

- **Enter N2, solve for N1**
  Select this option when you wish to fix \( N_2 \) at some value (or values), and then solve only for \( N_1 \). Please note that for some values of \( N_2 \), there may not be a value of \( N_1 \) that is large enough to obtain the desired power.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of \( N_2 \) to \( N_1 \), and then PASS determines the needed \( N_1 \) and \( N_2 \) with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
  \[
  N_2 = R \times N_1 .
  \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N_1 \) and \( N_2 \) with this percentage to obtain the desired power.

**N1 (Sample Size, Group 1)**
This option is displayed if Group Allocation = “Enter N1, solve for N2”
\( N_1 \) is the number of items or individuals sampled from the Group 1 population. \( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**
This option is displayed if Group Allocation = “Enter N2, solve for N1”
\( N_2 \) is the number of items or individuals sampled from the Group 2 population. \( N_2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
\( R \) is the ratio of \( N_2 \) to \( N_1 \). That is,
\[
R = \frac{N_2}{N_1} .
\]
Use this value to fix the ratio of \( N_2 \) to \( N_1 \) while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this ratio are considered.
\( N_2 \) is related to \( N_1 \) by the formula:
\[
N_2 = \lfloor R \times N_1 \rfloor ,
\]
where the value \([Y]\) is the next integer \( \geq Y \).
For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N_1 = 10 \) and \( N_2 = 20 \), or \( N_1 = 50 \) and \( N_2 = 100 \)).

\( R \) must be greater than 0. If \( R < 1 \), then \( N_2 \) will be less than \( N_1 \); if \( R > 1 \), then \( N_2 \) will be greater than \( N_1 \). You can enter a single or a series of values.

**Percent in Group 1**

_This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for \( N_1 \) and \( N_2 \).”_

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (\( N_1 = N_2 \))**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter \( N_1 \) and \( N_2 \) individually**
  
  This choice permits you to enter different values for \( N_1 \) and \( N_2 \).

- **Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \)**
  
  Choose this option to specify a value (or values) for \( N_1 \), and obtain \( N_2 \) as a ratio (multiple) of \( N_1 \).

- **Enter total sample size and percentage in Group 1**
  
  Choose this option to specify a value (or values) for the total sample size (\( N \)), obtain \( N_1 \) as a percentage of \( N \), and then \( N_2 \) as \( N - N_1 \).

**Sample Size Per Group**

_This option is displayed only if Group Allocation = “Equal (\( N_1 = N_2 \)).”_  

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \( N_1 \), and also the value for \( N_2 \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

**\( N_1 \) (Sample Size, Group 1)**

_This option is displayed if Group Allocation = “Enter \( N_1 \) and \( N_2 \) individually” or “Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \).”_

\( N_1 \) is the number of items or individuals sampled from the Group 1 population.

\( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,

\[
R = \frac{N2}{N1}
\]

Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:

\[
N2 = \lceil R \times N1 \rceil,
\]

where the value \([Y]\) is the next integer ≥ Y.

For example, setting \(R = 2.0\) results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If \(R < 1\), then N2 will be less than N1; if \(R > 1\), then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.
You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size
Input Type
Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the test statistics used in the power and sample size calculations are the same. This option is simply given for convenience in specifying the effect size.
The difference is calculated using the formula

\[
\delta = \mu_1 - \mu_2
\]

The choices are

- **Means**
  Enter \(\mu_1\) (Group 1 Mean) and \(\mu_2\) (Group 2 Mean).
• **Difference in Means**
  Enter the difference, $\delta$, directly.

Both choices also require you to enter the standard deviation, $\sigma$.

---

**Effect Size – Means**

$\mu_1$ (Mean of Group 1)
Enter a value for the assumed mean of Group 1. The calculations of this procedure are based on difference between the two means, $\mu_1 - \mu_2$. This difference is the difference at which the design is powered to reject equal means.

$\mu_1$ can be any value (positive, negative, or zero).

You can enter a single value, such as 10, or a series of values, such as 10, 20, 30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

$\mu_2$ (Mean of Group 2)
Enter a value for the assumed mean of Group 2. The calculations of this procedure are based on difference between the two means, $\mu_1 - \mu_2$. This difference is the difference at which the design is powered to reject equal means.

$\mu_2$ can be any value (positive, negative, or zero).

You can enter a single value, such as 10, or a series of values, such as 10, 20, 30, or 5 to 50 by 5. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

---

**Effect Size – Difference in Means**

$\delta$
Enter a value for the assumed difference between the means of Groups 1 and 2. This difference is the difference at which the design is powered to reject equal means.

$$\delta = \mu_1 - \mu_2$$

$\delta$ can be any non-zero value (positive or negative).

You can enter a single value, such as 10, or a series of values, such as 10, 20, 30, or 5 to 50 by 5. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

---

**Standard Deviation**

$\sigma$ (Standard Deviation)
The standard deviation entered here is the assumed, known standard deviation for both the Group 1 population and the Group 2 population.

$\sigma$ must be a positive number.

You can enter a single value, such as 5, or a series of values, such as 1, 3, 5, 7, 9, or 1 to 10 by 1. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Press the small 'σ' button to the right to obtain calculation options for estimating the standard deviation.
Example 1 – Finding the Sample Size

Researchers wish to compare two types of local anesthesia to determine whether there is a difference in time to loss of pain. Subjects will be randomized to treatment, the treatment will be administered, and the time to loss of pain measured. The anticipated time to loss of pain for one of the types of anesthesia is 9 minutes. The researchers would like to generate a sample size for the study with 90% power to reject the null hypothesis of equal loss-of-pain time if the true difference is between 2 and 10 minutes. How many participants are needed to achieve 90% power at significance levels of 0.01 and 0.05?

It is known that the standard deviation for each of the groups is 4.5.

It is unknown which treatment has lower time to loss of pain, so a two-sided test will be used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample Z-Tests Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample Z-Tests Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.01 0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Input Type</td>
<td>Means</td>
</tr>
<tr>
<td>$\mu_1$</td>
<td>11 to 19 by 1</td>
</tr>
<tr>
<td>$\mu_2$</td>
<td>9</td>
</tr>
<tr>
<td>$\sigma$</td>
<td>4.5</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>$\mu_1$</th>
<th>$\mu_2$</th>
<th>$\delta$</th>
<th>$\sigma$</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90078</td>
<td>151</td>
<td>151</td>
<td>302</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90163</td>
<td>107</td>
<td>107</td>
<td>214</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>4.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90022</td>
<td>67</td>
<td>67</td>
<td>134</td>
<td>12.0</td>
<td>9.0</td>
<td>3.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90423</td>
<td>48</td>
<td>48</td>
<td>96</td>
<td>12.0</td>
<td>9.0</td>
<td>3.0</td>
<td>4.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90299</td>
<td>38</td>
<td>38</td>
<td>76</td>
<td>13.0</td>
<td>9.0</td>
<td>4.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91190</td>
<td>25</td>
<td>25</td>
<td>50</td>
<td>14.0</td>
<td>9.0</td>
<td>5.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91518</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>14.0</td>
<td>9.0</td>
<td>5.0</td>
<td>4.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90515</td>
<td>17</td>
<td>17</td>
<td>34</td>
<td>15.0</td>
<td>9.0</td>
<td>6.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90423</td>
<td>12</td>
<td>12</td>
<td>24</td>
<td>15.0</td>
<td>9.0</td>
<td>6.0</td>
<td>4.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91775</td>
<td>13</td>
<td>13</td>
<td>26</td>
<td>16.0</td>
<td>9.0</td>
<td>7.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
</tbody>
</table>
Two-Sample Z-Tests Assuming Equal Variance

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>( \mu_1 )</th>
<th>( \mu_2 )</th>
<th>( \sigma )</th>
<th>( \alpha )</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90986</td>
<td>9</td>
<td>9</td>
<td>18</td>
<td>16.0</td>
<td>9.0</td>
<td>4.5</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91915</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>17.0</td>
<td>9.0</td>
<td>8.0</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91402</td>
<td>7</td>
<td>7</td>
<td>14</td>
<td>17.0</td>
<td>9.0</td>
<td>8.0</td>
</tr>
<tr>
<td>0.90</td>
<td>0.92280</td>
<td>8</td>
<td>8</td>
<td>16</td>
<td>18.0</td>
<td>9.0</td>
<td>9.0</td>
</tr>
<tr>
<td>0.90</td>
<td>0.93373</td>
<td>6</td>
<td>6</td>
<td>12</td>
<td>18.0</td>
<td>9.0</td>
<td>9.0</td>
</tr>
<tr>
<td>0.90</td>
<td>0.94313</td>
<td>7</td>
<td>7</td>
<td>14</td>
<td>19.0</td>
<td>9.0</td>
<td>10.0</td>
</tr>
<tr>
<td>0.90</td>
<td>0.93987</td>
<td>5</td>
<td>5</td>
<td>10</td>
<td>19.0</td>
<td>9.0</td>
<td>10.0</td>
</tr>
</tbody>
</table>

References

Report Definitions
Target Power is the desired power value (or values) entered in the procedure. Power is the probability of rejecting a false null hypothesis.
Actual Power is the power obtained in this scenario. Because N1 and N2 are discrete, this value is often (slightly) larger than the target power.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
\( \mu_1 \) and \( \mu_2 \) are the assumed population means.
\( \delta = \mu_1 - \mu_2 \) is the difference between population means at which power and sample size calculations are made.
\( \sigma \) is the assumed population standard deviation for each of the two groups.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
Group sample sizes of 151 and 151 achieve 90.078% power to reject the null hypothesis of equal means when the population mean difference is \( \mu_1 \ - \mu_2 = 11.0 - 9.0 = 2.0 \) with a standard deviation for both groups of 4.5 and with a significance level (alpha) of 0.010 using a two-sided two-sample equal-variance z-test.

These reports show the values of each of the parameters, one scenario per row.

Plots Section

![Plots Section](image-url)
These plots show the relationship between the mean for Group 2 and sample size for the two alpha levels.

To specify the difference directly to get the same results, change Input Type to Difference and enter 2 to 10 by 1 for $\delta$, leaving everything else the same. You may then make the appropriate entries as listed below, or open Example 1b by going to the File menu and choosing Open Example Template.

**Option**  
<table>
<thead>
<tr>
<th>Design Tab</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>$\delta$</td>
<td>2 to 10 by 1</td>
</tr>
</tbody>
</table>

**Output**

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>$\delta$</th>
<th>$\sigma$</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90078</td>
<td>151</td>
<td>151</td>
<td>302</td>
<td>2.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90163</td>
<td>107</td>
<td>107</td>
<td>214</td>
<td>2.0</td>
<td>4.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90022</td>
<td>67</td>
<td>67</td>
<td>134</td>
<td>3.0</td>
<td>4.5</td>
<td>0.010</td>
</tr>
</tbody>
</table>

The results are the same as those obtained when the means are entered.
Example 2 – Finding the Power

Suppose a new corn fertilizer is to be compared to a current fertilizer. The current fertilizer produces an average of about 74 lbs. per plot. The researchers need only show that there is difference in yield with the new fertilizer. They would like to consider the effect of the number of plots used on the power of the test if the improvement in yield is at least 10 lbs.

Researchers plan to use a one-sided two-sample z-test with alpha equal to 0.05. The known standard deviation for plot yield is 25 lbs. The plot group sizes of interest are 10 to 100 plots per group.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample Z-Tests Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample Z-Tests Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | Power
Solve For | Power
Alternative Hypothesis | One-Sided
Alpha | 0.05
Group Allocation | Equal (N1 = N2)
Sample Size Per Group | 10 to 100 by 10
Input Type | Means
μ₁ | 84
μ₂ | 74
σ | 25

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Two-Sample Z-Test Assuming Equal Variance</th>
<th>H₁: δ = μ₁ - μ₂ &gt; 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>N₁</td>
</tr>
<tr>
<td>0.22650</td>
<td>10</td>
</tr>
<tr>
<td>0.35199</td>
<td>20</td>
</tr>
<tr>
<td>0.46190</td>
<td>30</td>
</tr>
<tr>
<td>0.55725</td>
<td>40</td>
</tr>
<tr>
<td>0.63876</td>
<td>50</td>
</tr>
<tr>
<td>0.70748</td>
<td>60</td>
</tr>
<tr>
<td>0.76472</td>
<td>70</td>
</tr>
<tr>
<td>0.81191</td>
<td>80</td>
</tr>
<tr>
<td>0.85046</td>
<td>90</td>
</tr>
<tr>
<td>0.88171</td>
<td>100</td>
</tr>
</tbody>
</table>

These reports show the values of each of the parameters, one scenario per row.
Plots Section

This plot shows the relationship between the power and sample size.

Again, to specify the difference directly to get the same results, change Input Type to Difference and enter 10 for $\delta$, leaving everything else the same. You’ll get the same results as those above.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>$\delta$</td>
<td>10</td>
</tr>
</tbody>
</table>
Example 3 – Finding the Difference

In some cases it may be useful to determine how different the means of two populations would need to be to achieve the desired power with a specific constrained sample size.

Suppose, for example, that 80 subjects are available for a study to compare weight loss regimens. Researchers would like to determine which of the two regimens is better. The anticipated weight loss after two months is anticipated to be about 20 lbs. The researchers would like to know how different the mean weight loss must be to have a study with 90% power when alpha is 0.05 and the standard deviation is known to be 7 lbs. in both groups.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample Z-Tests Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample Z-Tests Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Effect Size (Means or Difference)</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>40</td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>δ</td>
<td>Search &gt; 0</td>
</tr>
<tr>
<td>σ</td>
<td>7</td>
</tr>
</tbody>
</table>

Reports Tab

Means, Difference Decimals.............. 3

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Two-Sample Z-Test Assuming Equal Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative Hypothesis: H1: δ = μ1 - μ2 ≠ 0</td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td>0.90000</td>
</tr>
</tbody>
</table>

If the true population mean weight loss for one group is 5.074 lbs. more or less than the other, the researchers would have 90% power to show a difference between the groups.
Example 4 – Validation of Sample Size using Chow, Shao, and Wang (2008)

Chow, Shao, and Wang (2008) pages 63 and 64 present an example for a two-sided test in which the mean difference is 0.05, the common standard deviation is known to be 0.10, the power is 80%, and the significance level is 0.05. They calculate the per group sample size as 63.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample Z-Tests Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample Z-Tests Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>δ</td>
<td>0.05</td>
</tr>
<tr>
<td>σ</td>
<td>0.1</td>
</tr>
<tr>
<td>Reports Tab</td>
<td></td>
</tr>
<tr>
<td>Means, Difference Decimals</td>
<td>2</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Numeric Results for Two-Sample Z-Test Assuming Equal Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative Hypothesis: H1: δ = μ1 - μ2 ≠ 0</td>
</tr>
<tr>
<td>Target Power</td>
</tr>
<tr>
<td>0.80</td>
</tr>
</tbody>
</table>

The sample size of 63 per group matches Chow, Show, and Wang’s result exactly.